
 
    Guide to U-Lead Browser

This help is divided into eight parts. The first part introduces the U-Lead Browser program. The second 
part contains procedures which will help you work efficiently with U-Lead Browser. The third and fourth 
parts cover the menu commands and tool palette while the fifth part includes some technical information
about entries in the BROWSER.INI file. The sixth part is a simple explanation of the INSTALLER.EXE 
program and the last two parts provide simple definitions of some of the terminology used and an 
introduction to the ImagePals 1.2 package.

To explore a particular part, click on the appropriate button:

Introducing U-Lead Browser...
Procedures
Menu commands
Tool palette
BROWSER.INI
INSTALLER.EXE
Glossary
ImagePals 1.2

Other information



 
    Introducing U-Lead Browser...

U-Lead Browser provides more than just a catalog of the images on your CD-ROM. Being able to 
visually browse your images and use powerful search and sorting commands, you can easily find the 
right image at the right time. With support for drag-and-drop, OLE, and over twenty file formats, you will 
never be short of options when it comes to linking applications and placing files into your desktop 
publishing, presentation, and word processing documents. 

A few of U-Lead Browser's features

Other information
Supported image data types
Supported file formats



 
Introducing ImagePals...

U-Lead Browser is specifically designed to provide quick and easy access to images and graphics on 
CD-ROM. To benefit from a more flexible working environment that includes image enhancing and 
screen capturing tools, you should upgrade to ImagePals 1.2.

ImagePals is a friendly environment for processing images and organizing a wide variety of files. The 
three seamlessly integrated programs: Album, Capture, and Enhancer, help make your daily tasks easy,
intuitive, and well,...fun!

To find out more about a particular program or the features shared by all three, click on the appropriate 
button:

Album
Enhancer
Capture
Shared features

Other information
Upgrade information



 
    Album

Album helps you organize files of all types into collections in much the same way as you organize 
photographs in photo albums. These collections are known as albums. As you collect files, "thumbnail" 
representations of them are created and placed in the album of your choice. These thumbnails provide 
a tactile means to find and organize your files and even manage them on disk.

Album also acts as the hub of your image processing: providing direct access to the other ImagePals 
programs and other applications. Following are just a few of Album's unique features:

automatic and manual file collection.
display of thumbnails or filenames of files in albums.
manual and automatic thumbnail sorting.
search, browse, and sort options across multiple albums.
"drag-and-drop" files from albums to other programs, and from Windows File Manager (under 

Windows 3.1) directly into albums.
update albums/files with the Check and Relink commands.
archive (backup and restore) albums and files.
access other applications direct from Album's workspace.
preview and display image and graphics files in a Slide Show presentation.
a "shelf" for storing albums.



 
compatibility with a variety of image and graphics file formats.
conversion between file formats.
support for Black & White, Grayscale, Indexed 16- and 256-Color, and RGB True Color image 

data types.
support for JPEG, LZW, and RLE compression.
display of thumbnails or filenames of files in albums.
manual and automatic thumbnail sorting.
search, browse, and sort options across multiple albums.
access other applications direct from Album's workspace.
support for Windows Object Linking and Embedding (OLE).
preview and display image and graphics files in a Slide Show presentation.
a "shelf" for storing albums.
monitor gamma calibration.
printing to output devices supported by Windows, including PCL and PostScript printers, film-

recorders, and high-resolution imagesetters.
Batch Manager to apply commands to multiple albums.
full support for "drag-and-drop" under Windows 3.1 and partial support under Windows 3.0.
preferences to customize operating conventions.



 
Accessing other albums

U-Lead Browser allows you to access album files from any drive connected to your system, be it a 
network drive, CD-ROM drive, optical drive, or whatever. If you are sharing a CD-ROM or other drives 
you can use albums at the same time as other users if they are read-only albums: ones that are in read-
only directories or have been made read-only (with the DOS "ATTRIB" command or with File Manager's
File: Properties command).

If an album is not read-only, e.g. one created by the full version of album on a network drive it can only 
be used by one person at a time. If you try to open such an album that is already in another user's 
workspace, you will be told that the album is in use and that it will be placed on your shelf. You can only 
open the album when it is removed from the other user's workspace, or that user exits album.

Note: the number of albums you can have open in the workspace is limited to twelve, but on the shelf 
you can have up to 142. 



 
    Enhancer

Enhancer has been developed specifically to satisfy all your image processing needs. It has just the 
right combination of image enhancing and editing capabilities. From scanning, improving any type of 
image to outputting, or even creating your own image, Enhancer does it all.

The best part about Enhancer is that you don't have to be an image processing expert to use it. Some 
of its features include:

image input from scanners and many other input devices.
compatibility with TWAIN input devices.
automatic or manual combining of parts of images to create new images. 
selection tools and commands to select part or parts of an image and subsequently edit only 

those parts.
commands to save and load selection areas as editable masks.
controls to adjust gamma, hue, saturation, brightness, and contrast: all of which help you to 

enhance an image or selected area.
support for multiple image windows. 
painting tools, image processing filters, and transformation commands to help you modify an 

image or selected area.
save new images to Album and automatically update existing thumbnails.



 
    Capture

Capture is a versatile and intuitive screen capture program that serves as an invaluable component of 
your image processing strategy. Aside from capturing screens, it also provides viewing, editing, saving, 
and extensive conversion functions. These functions and the ability to apply commands to a large 
number of images in a single operation make Capture a very powerful production tool. Following are 
just a few of Captures unique features:

capture interface components from any Windows screen, image data from the clipboard, or 
resources from execution Files.

capture screens with or without a cursor.
capture images to the Capture workspace, to a File on disk, to the clipboard, to any Windows-

compatible printer, or to any combination of these destinations.
immediate, delayed, and consecutive capturing.
save new images to Album and automatically update existing thumbnails.
convert to and from the RGB HiColor data type in addition to other data types.
user-defined hot key and activation.
post-processing commands to convert, expand, or change the resolution of images as they are 

captured.
change the Windows color scheme from within Capture.
quick access to major options via the ribbon and, when minimized, through the Capture icon's 

control menu.



 
Shared features

As a family, the ImagePals programs share a similar look and feel and many common features. These 
include:

support for Black & White, Grayscale, Indexed 16- and 256-Color, and RGB True Color image 
data types.

compatibility with a variety of image and graphics file formats.
conversion between file formats.
support for JPEG, LZW, and RLE compression.
ability to view images at different magnifications.
monitor gamma calibration.
printing to output devices supported by Windows, including PCL and PostScript printers, film-

recorders, and high-resolution imagesetters.
Batch Manager to apply commands to multiple files.
commands to undo and redo operations.
full support for "drag-and-drop" under Windows 3.1 and partial support under Windows 3.0.
preferences to customize operating conventions.
support for Windows Object Linking and Embedding (OLE).
quick access to the other ImagePals programs via the Pals menu.



 
Image data types

In the same way that you can have color displays and monochrome displays, you can have different 
types of images. U-Lead Browser supports five types (image data types). Each type is distinguished by 
the number of "bits" of data it supports. The number of bits controls the number of colors available. You 
can work out this number by raising two to the power of the number of bits, e.g. an 8-bit data type gives 
a possible 256 colors.

U-Lead Browser supports the following data types:

Black & White
Grayscale
Indexed 16 and 256-Color
RGB True Color

Other data types
RGB HiColor
RGB 8-Color



 
File formats

Hardware and software manufacturers have developed different ways, or file formats, to save different 
types of digital data. U-Lead Browser supports a wide variety of file formats. Within any album you may 
find images and graphics in a variety of formats in addition to "application-linked" files. Application-
linked files retain a link to their original application enabling you to open, view, and edit the file in that 
application direct from Album.

Image and graphic file formats



 
Image and graphic file formats

The following file formats are supported by U-Lead Browser. 

Windows Bitmap (BMP)
Computer Graphics Metafile (CGM)
Windows Clipboard file format (CLP)
Windows Cursor file format (CUR)
ASCII AutoCAD file format (DXF)
Encapsulated PostScript (EPS)
Graphics Interchange Format (GIF)
Windows Icon file format (ICO)
GEM Image file format (IMG)
JPEG file interchange format (JPG)
MacPaint file format (MAC)
Microsoft Paint file format (MSP)
Lotus Picture format (PIC)
Kodak PhotoCD file format (PCD)
Macintosh PICT file format (PCT)
PC Paintbrush (PCX)
Sun Raster file format (RAS)
Run-length encoded file format (RLE)
Targa (TGA)
Tagged Image File Format (TIF)
Windows Metafile format (WMF)
DrawPerfect file format (WPG)

When you convert images or graphics to some of the above formats you are given options.
Convert File Format dialog box



Glossary

To find out the definition of a particular image processing term, click on the appropriate button.

Aspect ratio
Averaging
Bit
Bitmap
Black and white
Brightness
Channel
Client
Clipboard
Clone
Color model
Complementary color
Compression
Contrast
Data type
Dithering
Embed
File format
Filters
Graphics files
Halftoning
HiColor
HSB
Image
Link
Mask
OLE (Object Linking and Embedding)
Pixel
Prime colors
Resolution
RGB
Saturation
Server program
Thumbnail
Transformation
True Color



 

Using Help

This Help contains the following buttons to speed your search for specific information:

Bulleted items list commands and features
Definition buttons provide background information
Topic buttons display associated topics
Dialog box buttons provide details about a command's dialog box
Procedure buttons display step-by-step instructions

To jump direct to a topic from within your program, press F1.



 
Black & White is a one-bit data type. In a Black & White image, each pixel can be only white or 
black. Shades of gray can be simulated by arranging black and white pixels in such a way that 
they appear to be gray.

For example, a square of 4 pixels by 4 pixels (16 in all) can appear to be gray (a 50% tint of 
black) if eight black pixels and eight white pixels are properly arranged. Changing the mix of 
black and white pixels can darken or lighten the shade of gray the eye perceives.



 
Grayscale is a 256-color (8-bit) data type. Each pixel in a Grayscale image can be black, white, 
or any one of 254 different shades of gray. 

Choose this data type when you want to prepare images for a publication printed in a single 
color. If you want to introduce color into an image, convert it to RGB True Color.



 
Indexed-color images are images which have a "color table" incorporated into their description. 
This color table contains all the colors that can appear in the image. For Indexed 16-Color 
images, the color table has 16 colors (4-bit); for Indexed 256-Color images, the color table 
contains 256 colors (8-bit).

Most functions can be applied to indexed-color images, but to get full benefit from the more 
advanced editing features, convert indexed-color images to RGB True Color.



 
The initials RGB stand for Red, Green, and Blue. The data type bears this name because all 
available colors are created with different amounts of red, green and blue. In fact there are 256 
shades of each available and mixing them together can result to any of 16.7 million possible 
colors. Hence the term True Color.



 
This data type has been introduced in conjunction with the influx of 15 and 16-bit color (32,000 
and 64,000 colors). RGB HiColor display cards provide a lower-cost alternative to True Color 
cards for high quality color representation. You may want to use this data type if you are 
capturing images from a HiColor display. If 64,000 colors are enough for your needs, you can 
save images in this data type to save space on your hard drive. An RGB HiColor image 
occupies 33% less memory space than an RGB True Color image.

Note: To retain true HiColor images, you must keep them in the TGA format. The other formats 
do not support a 16-bit data structure. 



 
This is an old image data type that you can open but not save. When opened, RGB 8-Color 
images are automatically converted to Indexed 16-Color.



 
This is the standard Windows file format that allows Windows to display an image consistently 
on different devices (with similar capabilities). You will normally only use this format for indexed-
color images or for images to be used later in applications like Windows Paintbrush or in 
Windows itself (as, for example, your "Wallpaper"). 



 
This is a device-independent file format that retains enough information to be output direct to a 
printer, or imported into another application.



 
Developed by CompuServe to allow device-independent transfer of images. GIF supports 
images up to 64 MB in size with up to 256 colors (8-bit). This file format does not record image 
resolution, so don't use this format if retaining the resolution is important.



 
Developed by the Joint Photographic Experts Group (JPEG), this file format is a relatively new 
industry-standard compressed file format. Unlike many other compressed file formats, this one 
is "lossey", i.e. some data is discarded to achieve the best possible compression ratio of up to 
100:1. The data that is considered to be least important to the human perception of images is 
discarded so, although there is sometimes an appreciable reduction in quality, you can normally 
balance the loss of quality with the compression ratio to achieve a happy compromise.



 
Developed by ZSoft Corporation for PC Paintbrush. This is the default format used by some 
scanning and painting applications (including PC Paintbrush). This format supports HiColor 
images in a 24-bit format. PCX has one advantage over the TGA format in that it incorporates a 
lossless compression scheme which results in the same file occupying less space on disk.



 
This is a format used by many specialist systems and you will probably know if you need to use 
it. It is the only format that supports a 16-bit format for HiColor images. When you save HiColor 
images in this format, they occupy less disk space than if you use a format, such as TIF, that 
saves them as True Color (24-bit).



 
Developed by Aldus and Microsoft to promote the use of desktop scanners and DTP (desktop 
publishing), non-compressed TIF is hardware and software independent, but there are many 
types which are not. Choose this format for compatibility with most other applications and to 
have the option of file compression.



 
An ISO Computer Graphics Metafile file format, CGM is a very popular vector graphic format. 
You can read CGM files but cannot write to this format.



 
CLP is the Windows clipboard format and may contain a device-independent bitmap (DIB), 
device-dependent bitmap (DDB), or a metafile. CLP bitmaps support Black & White, Indexed 16-
and 256-Color, and RGB True Color images. You can both read and write files in this format.



 
This is the Windows Cursor resource file format. You can read CUR files but cannot write to this 
format. When cursor files are opened inverted areas are converted to black; transparent areas 
to white.



 
This is the ASCII AutoCAD file format that supports 2-D vector graphics files. You can read DXF 
files but cannot write to this format.



 
ICO is the Windows Icon resource file format. Icon resource files may contain more than one 
image for a particular resolution. Icons have dimensions of 16×16, 32×32, or 64×64 with 2, 8, or 
16 colors. Although you can both read and write files in the ICO format, XOR and AND mask 
information is interpreted as fixed colors.



 
IMG is an image file format developed by Digital Research Corp. for use by programs operating 
in the GEM environment. IMG files are compressed and support Black & White and Indexed 16-
Color images. You can both read and write files in the IMG format.



 
A fixed size, Black & White image format, MAC was developed for the Macintosh Paint 
application. You can both read and write files in the MAC format. (These files sometimes have 
the PNT file extension.)



 
MSP is the old Microsoft Paint format and only supports Black & White images. You can read 
and write files in the MSP format.



 
PIC is the format in which Lotus 1-2-3 saves vector-type charts and graphs. You can read PIC 
files but cannot save files in this format.



 
Developed by Kodak for its PhotoCD products, PCD supports Grayscale, Indexed 256-Color, 
and RGB True Color images. You can read PCD files but cannot save files in this format.



 
PCT is the Macintosh PICT (I & II) file format that can record both vector graphics and image 
(bitmap) data. You can read PCT files but cannot save files in this format.



 
This is a raster file format developed by Sun Microsystems. It supports Black & White, 
Grayscale, Indexed 256-Color, and RGB True Color image data as well as options for RLE 
compression, and byte and color ordering (when saving). You can both read and write files in 
the RAS format.



 
RLE is a Windows bitmap format supporting Indexed 16- and 256-Color images saved with RLE
compression. You can both read and write files in the RLE format.
Note: The most notable use of this format is for the Windows start-up logo, VGALOGO.RLE.



 
WMF is an image file format used by many Windows-based graphic and image processing 
applications. As well as supporting Black & White, Indexed 16- and 256-Color, and RGB True 
Color images, WMF files can be, or can include graphics data.



 
A graphics format that can record both vector and image (bitmap) data. WPG was developed for
WordPerfect and is used by DrawPerfect. You can read WPG files but cannot save files in this 
format.



 
When installed, programs record their proprietary formats and any formats they expect to open. 
Windows Notepad, for example, records text files as one type of file that will open in it.



 
This command opens a dialog box in which you can find out the program a format is linked to by
typing the extension in the Files, with extension, entry box.

You can also change the association of files (see your File Manager's Help Associate Files with 
Applications topic). This command is the method Microsoft recommends for editing the 
database.



 
This section is a survivor of the upgrade from Windows 3.0 to 3.1. You can manually edit this 
section and add new entries but File Manager's Associate command is a more interactive and a 
safer means of doing this (changes made with the Associate command are reflected in this 
section but this section is not necessarily a complete record of the associations).



 
(The REG.DAT file in your Windows directory). Microsoft does not advise you to edit this 
yourself but they provide a utility, REGEDIT.EXE, with which you can view and edit it. Before 
you make any changes, we suggest you read the Registration Info Editor Help as this is the 
most complete documentation of this utility available to most people.
The entries in this database determine which files will be displayed when you select the 
Insert/Collect: Application-linked files options. In normal operation, this also determines the 
thumbnails that will be placed into your albums to represent different files. 



 
Aspect ratio is the ratio of width to height in an image or display device. 



 
Averaging is a filtering process which takes the gray/color value of each pixel and averages it 
with the values of surrounding pixels. The value of each pixel is then replaced with the averaged
value.



 
A bit is the smallest element in a computer's memory. Bits are used to record the color values of 
pixels in an image. The more bits used for each pixel, the greater the number of available 
colors.

1-bit: each pixel is either black or white.
8-bit: each pixel can be any one of 256 colors or grays.
16-bit: each pixel can be any one of over 64,000 colors.
24-bit: each pixel can be any one of 16.7 million colors.



 
An image made up of a collection of dots or "pixels" arranged in rows.



 
An image that only contains black and white pixels.



 
The brightness of an image is a description of how much light appears to be emitted from it. An 
absence of light (black), has zero brightness; pure white light has maximum brightness.



 
Refers to one of the components of a color model. Different color models use different 
components to represent image colors. The RGB color model uses red, green and blue color 
component channels. The HSB color model uses hue, saturation and brightness color channels.
Grayscale images can be thought of as single-channel images.



 
A program whose documents can accept objects linked to server programs. 



 
A temporary storage area used to hold images or portions of images during cut, copy, and paste
operations.



 
To make an exact copy. In Enhancer, the Paintbrush Options allow you to duplicate part of an 
image in another part of the image.



 
A color model is a way to visualize colors and how they relate to each other. Many different color
models exist, each of which has a specific purpose; e.g. the RGB model is used to specify 
colors on computer monitors, and the HSB model provides us with a model that is easy for us to
imagine.



 
Complementary colors are colors that are opposite in value to other colors. We often refer to 
cyan, magenta, and yellow as being the complementary colors of red, green, and blue.



 
Method of making image files smaller on disk. There are two types of compression: lossless and
lossey. Files compressed with a lossless compression scheme can be restored to their original 
state. Lossey schemes discard data and so images when decompressed, may show quality 
degradation. Schemes of both types are provided, depending on the format of a given image 
file.



 
The contrast of an image is the difference between light and dark pixels. In an image with high 
contrast, the transition between dark and light is very clear; in an image with low contrast, the 
transition is less marked.



 
The way an image is internally represented by a computer. The data type of an image controls 
the amount of information that the image can retain and therefore its displayed appearance. You
can read and write the following types: Black & White, Grayscale, Indexed 16- and 256-Color, 
RGB HiColor and RGB True Color. RGB 8-Color images can also be read, but they are 
automatically converted to Indexed 16-Color.

To retain true RGB HiColor data, you should keep HiColor images in the TGA format. If you 
convert them to the PCX or TIF formats the data is converted to RGB True Color. 



 
Method of making images with limited colors available appear to contain more. Most notable for 
making Black & White images appear to contain near-continuous changes in tone (grays). By 
arranging pixels of different colors close together, dithering can simulate colors not directly 
supported by an image data type. The various dithering techniques differ in the way they 
calculate and arrange new pixel values.



 
To create a copy of an object from one program, a server program, in the document of another 
program, a client program. The embedded object retains a link to its server program and may be
edited directly from the client. 



 
File formats are ways in which a computer stores image information on disk.



 
A set of commands which allow you to enhance images and create special effects. Enhancer 
provides the following filters: Average, Blur, Sharpen, Edge Enhancement, Find Edge, Mosaic, 
and Emboss.



 
In general terms a file that may contain both image (bitmap) data and vector graphics. 
Commonly, and in this case, taken to mean a File that is primarily for vector graphics. Vector 
graphics do not have a basic component, like a pixel. They are defined as lines between points, 
and fills between lines. 



 
A method of using a pattern of black and white dots to produce what appears to be a shade of 
gray. This is a common type of dithering.



 
HiColor normally refers to a 16-bit data type that can contain up to 64,000 colors. The TGA file 
format supports images of this type. Other file formats require prior conversion of a HiColor 
image into True Color. For displays, HiColor normally refers to 15-bit display adapters that can 
display up to 32,000 colors.



 
HSB is a color model that specifies colors in a way that is easier for people to visualize than the 
RGB model. H represents the hue, or basic color; S represents the saturation, or purity of the 
color; and B represents the Brightness, or amount of light the color appears to emit.



 
An image is a reproduction, or picture of something. In this case, the term is used to describe 
digitized pictures, consisting of pixels, which can be shown on a computer display and 
manipulated by image enhancement software.



 
To create a reference in the document of a client program to an object in a server program. The 
linked object can be edited directly from within the client program. When the object changes in 
the server program, the changes are automatically reflected in the client program.



 
Traditionally, masks are used to protect areas of an image from inadvertent editing and painting.
In Enhancer, you can select areas to control the application of commands and tools and save 
these areas as masks. Once saved, masks can be edited to suit particular tasks and create 
special effects.



 
A means of transferring and sharing information such as images, text or other objects between 
applications. 



 
The smallest unit in an image. Computer images are made up of rows of pixels, each of which 
can be a different color. Pixels are normally so small that you see the image created by a 
collection of them. 



 
The prime colors are the basis of the RGB color model: red, green, and blue. With different 
amounts of each of these colors, on screen, it is possible to create any other color.



 
The resolution of an image determines the size of the individual pixels in an image, and thus the
size of the whole image. Resolution is shown in pixels per inch (PPI) or dots per inch (DPI).



 
RGB is a color model used to define colors by specifying the red, green, and blue components 
of colors. This is one of the standard color models used to specify and record colors on a 
computer. (See Color model.)



 
Saturation defines the purity of a color. A color with a high saturation appears very intense and 
strong, a color with low saturation appears washed out.



 
A server is a program that allows you to take objects from it and place them into a document in 
another, a client program. U-Lead Browser can act as a server program. 



 
A small, low-resolution representation of an image. Thumbnail is one of the ways in which the 
Album program can display images.



 
The Enhancer program provides various transformation commands that allow you to create 
special effects in images or selections. These commands include Flip, Rotate, Free Resize and 
Slant.



 
Something that can display enough colors to appear "True" to life. For an image this normally 
means 24-bit color, providing up to 16.7 million colors.





 

Menu Commands

The U-Lead Browser menus are located in the menu bar and each menu contains a set of commands. 
To find out more about a particular command from one of the menus, click on the appropriate button.

Album Menu
Edit Menu
Thumbnail Menu
View Menu
Window Menu
Help Menu

Other information
Window control menu commands
Tool button menu commands



 

Album Menu

The Album menu contains commands for managing and printing albums.

New creates a new album
Open opens albums from the workspace, shelf, or disk drive
Update updates the object in a client program with the currently selected thumbnails' file
Batch Manager allows you to carry out operations on multiple albums
Shelf displays the Shelf dialog box to let you move albums between the shelf and the workspace
Delete removes an album from the workspace 
Print prints the files or thumbnails from the active album
Printer Setup selects the printer you want to use
Preferences displays a dialog box containing options to customize some of U-Lead Browser's 

features
Exit closes the U-Lead Browser window



 

Print sub-menu

U-Lead Browser allows you to print all types of files or their thumbnails to any Windows-compatible 
output device. Images and thumbnails are printed directly while application-linked files are output via 
their linked application. Before you print, make sure that your printer is turned on, connected and 
selected in the Windows Printer Setup dialog box. Set up your printer with the Printer Setup command 
in the File menu.

The Print sub-menu of the Album menu contains two options. The option you select determines what 
will be sent to the printer currently selected in the Printer Setup dialog box.

File Content prints the files of selected thumbnails from the active album. If you select image 
files, the Print Image dialog box appears; printing of application-linked files is controlled by their linked 
applications.

Thumbnails prints all the thumbnails contained in the album with the option to print 
accompanying information



 

Edit Menu

Use the Edit menu to undo and repeat the last applied command, and select images.

Undo reverses the effect of the last applied command (if possible)
Repeat repeats the effect of the last applied command
Copy duplicates selected thumbnails, image files, or filenames onto the clipboard
Clear deletes selected thumbnails from the album
Select selects, deselects, or inverts the currently selected thumbnails



 
Copy sub-menu

The Copy sub-menu in the Edit menu contains three options. The option you select determines what will
be copied onto the clipboard.

File Content duplicates the contents of selected thumbnails' files (either image or graphics) onto 
the clipboard

Thumbnail duplicates selected thumbnails onto the clipboard
Filename duplicates the full path and filename of selected thumbnails' files



Select sub-menu

The Select sub-menu of the Edit menu contains three options by which you can select or deselect 
thumbnails in the active album.

All selects all thumbnails in the active album
None deselects all thumbnails in the active album. Clicking on the album's status line also 

deselects all images.
Invert selects the thumbnails which are not currently selected. For example, if you have five 

thumbnails in an album and one is selected, when you apply the Invert command, the four unselected 
thumbnails are selected and the previously selected one is deselected.



 

Thumbnail Menu

The Thumbnail Menu contains commands you can apply to the images contained in the active album.

Search finds images with specific attributes in the active album
Copy duplicates the files of selected thumbnails in another directory
Convert converts the image files of selected thumbnails to other file formats



 

View Menu

The commands in the View menu change the number and sequence of thumbnails displayed in an 
album and control the way different elements are viewed.

All makes all images in the album available for display
Partial allows you to limit images available for display to those with common attributes
Sort By allows you to change the sequence by which images are displayed without affecting their

original arrangement
Thumbnails displays the thumbnails of images contained in the album
Filenames displays the filename of each image in the album along with some information
Slide Show displays image/graphics files from the active album in a slide show presentation
File Content displays the file of the currently selected thumbnail
File Information displays a dialog box containing information about a selected thumbnail's file
Album Information displays a dialog box containing information about the active album
Show/Hide Tools displays/removes the tool palette from the workspace



 

Window Menu

The Window Menu contains commands for managing images in the workspace.

Cascade stacks open album windows so that the title bars are visible
Tile resizes all open album windows to the same size and arranges them to fill the workspace 
Arrange Icons arranges all minimized album icons along the bottom of the workspace
Window List contains the titles of all album windows currently in the workspace



 

Help Menu

The Help menu contains commands to help you use U-Lead Browser.

Contents starts Help and displays the topics in the Album Help
Search for Help on opens the Search dialog box containing keywords from the Help topics
How to Use Help accesses the Windows guide to using Microsoft Help
About U-Lead Browser displays the U-Lead Browser product information box

Other information



 

    Window control menu

Most windows have the following commands in their control menu. To access the control menu, click on 
the box in the top left corner of the window. Many control menus will contain an additional command at 
the bottom, such as Next..., Run..., or Switch to.., these commands allow you to swap between 
windows.

Restore restores a window to its normal size (i.e. the size it was before being maximized or 
minimized)

Move allows users to move the window without using the mouse
Size allows users to change the size of the window without using the mouse
Minimize reduces the window to an icon
Maximize enlarges the window to fill all available space (either on screen or within a parent 

window)
Close closes the window



 

BROWSER.INI

When you run U-Lead Browser for the first time, a BROWSER.INI file is created in your Windows 
directory. This file records information that you, as a user, may change while using Browser, e.g. if you 
create a new album it is recorded in this file. You can also, using a text editor, manually add some 
special entries to adjust certain aspects of Browser's operation. This topic explains these special 
entries, if you add any of them, they should be inserted into the [U-Lead Browser] section as follows:

[U-Lead Browser]
Handles=12
ConvertBitmap=1
DIB=1
DDB=1
RelativeTo=D:

Other information
The BROWSER.INI file on the CD-ROM



 

INSTALLER.EXE

Although U-Lead Browser is ready to use direct from your CD-ROM, you can choose to install it on your
hard drive. When you run it from your hard drive the speed of operation may increase slightly.

The installation program, INSTALLER.EXE, is provided for this purpose. Simply run this program, under
Windows, from your CD-ROM and all the files required to run U-Lead Browser will be copied to your 
hard drive. The installation program also gives you a choice of adding the Browser icon to a program 
group: no other changes are made to your system.







 

Create Album dialog box

Clicking the New button in the Save Image File dialog box displays the Create Album dialog box. Use 
this dialog box to specify a new album's title and description, as well as the size of the thumbnails.

Title allows you to define the title of the album (up to 23 characters)
Thumbnail defines the size of thumbnails the new album will contain
Description allows you to enter a description for the new album (up to 127 characters)
Display thumbnails in Grayscale displays thumbnails in the album as gray images on a 16-

color display



 

Album Shelf dialog box

Selecting the Album Shelf command from the Album menu or clicking on the shelf button in the tool 
palette displays the Album Shelf dialog box. This dialog box allows you to move albums between the 
shelf and the workspace. It also provides options to get information about a particular album and delete 
it from disk.

Albums in workspace displays the titles of all albums in the workspace
Albums on Shelf displays the titles of all albums on the shelf
=> moves the selected album from the Albums in workspace list onto the shelf
<= moves the selected album from the Albums on shelf list into the workspace
Info displays a dialog box containing information about a selected from either the Albums on shelf

or Albums in workspace list boxes
Delete removes the album file selected in the Albums on shelf list box from Album and deletes 

the album's file from disk



 

Delete Album dialog box

Selecting the Delete command from the Album menu displays the Delete Album dialog box. This dialog 
box contains options you can choose to delete the active album from the workspace and/or from disk 
and delete its associated files

Remove from workspace closes the album, removing it from the workspace without deleting the
album file

Delete album file deletes the album file from disk (and the workspace)
Delete associated files deletes all the files referenced in the album from disk



 

Set Margins dialog box

Clicking on the Margins button in the Print Thumbnails dialog box displays the Set Margins dialog 
box.Use this dialog box to specify the margins and spacing you want to use on your output pages.

Margins defines the margins of the output page
Minimum spacing defines the spacing between thumbnails on the output page
Unit displays the current unit of measure used by all the entry boxes
OK returns you to the Print Thumbnails dialog box



 

Search for Thumbnails dialog box

Selecting the Search command from the Thumbnail menu displays the Search for Thumbnails dialog 
box. This dialog box contains search options to make finding thumbnails of particular files easy. Set the 
search criteria to search for specific file attributes. If you select more than one condition, they will all be 
combined and only thumbnails of files that satisfy all conditions will be located.

Filename allows you to enter the filename associated with the thumbnail you are searching for
NOT selects the opposite condition (i.e. search for everything except the thing you select)
Description can be used to type in the description, or any part of it, of the thumbnail you are 

searching for
Match Case makes the Description search case sensitive (i.e search for M or m)
Match whole word makes the Description search a word that is not embedded in another word 

(i.e search for 'any' but not 'many')
File Size allows you to enter the minimum and maximum sizes for files to be searched for
Data type allows you to specify the type of file to search for
Date allows you to define the period of time in which the associated file was last saved
Goto closes this dialog box and displays the Go to Thumbnail dialog box or a message indicating

no thumbnails were found
Select closes this dialog box and returns you to the active album in which all thumbnails 

satisfying the search criteria are selected

This operation can be applied to multiple albums with the Batch Manager
Batch Manager



 

View Partial Album dialog box

The Partial command from the View menu allows you to view a portion of the images contained in the 
active album. When you choose this command, the View Partial Album dialog box appears. Use the 
options contained in this dialog box to specify the common attributes of images to be displayed in the 
album.

Filename allows you to enter the filename of files to display
NOT selects the opposite condition (i.e. display everything except the thing you select)
Description allows you to enter the description of the thumbnails you want to display
Match Case makes the Description entry case sensitive (i.e M or m)
Match whole word makes the Description search a word that is not embedded in another word 

(i.e search for 'any' but not 'many')
File Size allows you to enter minimum and maximum sizes for files to be displayed
Data type allows you to specify the type of file to display
Date allows you to define the period of time when the files to be displayed were last saved



 

Go to Thumbnail dialog box

This dialog box appears when files are found matching your search criteria in the Search for Files dialog
box.

thumbnails found shows how many thumbnails satisfy the search criteria and lists them all
Album displays the name of the album that contains a file selected in the list box
Goto displays the album containing the thumbnail selected in the thumbnails found list box and 

indicates the thumbnail with a yellow arrow



 

Slide Show dialog box

Selecting the Slide Show command in the View menu displays the Slide Show dialog box. Use this 
dialog box to create a slide show presentation of all the images and graphics from the active album or 
just those whose thumbnails have been selected. Press the Esc key to stop the slide show.

Transition
Effect allows you to choose the effect applied when each "slide" replaces the previous one
Automatically triggered makes the slides automatically change with the specified delay in 

between each
Manually with keyboard or mouse allows you to manually change the slides. The manual 

controls are displayed before the slide show.
Repeat till quit makes the slide show continue until you stop it, displaying all images and 

graphics in rotation
Hide cursor hides the cursor during the slide show



 

Slide Show Controls dialog box

When you select the Manually with keyboard or mouse option in the Slide Show dialog box and click 
OK, the Slide Show Controls dialog box appears. This dialog box displays the full list of available 
keyboard commands with which you can control the slide show (see the Working with ImagePals guide,
p.52, for a printed version of this dialog box).

Click OK to start the slide show.



 

Remove Tools dialog box

Selecting the Remove command from the tool palette's configuration menu displays the Remove Tools 
dialog box. Use this dialog box to remove a program icon from the tool palette. Remove only the 
programs which you would not be using in the future.

Tools shows the names of all programs currently in the tool palette
Filename displays the full path and filename of a program selected in the Tools list box
Remove removes a selected program from the tool palette. You can remove as many programs 

as you like, before closing the dialog box with the Close button



 

Modify Tools dialog box

Selecting the Modify command from the tool palette's configuration menu displays the Modify Tools 
dialog box. Use this dialog box to modify the name and/or optional parameters assigned to a program 
icon in the tool palette.

Name displays and allows you to edit the name that will appear under the program's icon in the 
tool palette

Optional parameters displays and allows you to edit the text that will be added to the program's 
command line when executed

Tools shows the names of all programs currently in the tool palette
Filename displays the full path and filename of a program selected in the Tools list box
Modify applies the changes you made to the selected program. You can modify as many 

programs as you like, before closing the dialog box with the Close button



 

Rearrange Tools dialog box

Selecting the Rearrange command from the tool palette's configuration menu displays the Rearrange 
Tools dialog box. Use this dialog box to change the arrangement of the programs icons currently in the 
tool palette.

Tools shows the names of all programs, in the order they appear, currently in the tool palette
Top and Bottom place a selected program at the top or bottom of the Tools list
Up and Down move a selected program up or down the list one place at a time





 
After "deleting" an album with this option, you can reopen it with the Open command in the 
Album menu.



 
Once deleted, the album file cannot be recovered by Album unless you have a backup.

With this option selected, Remove from workspace is automatically selected.



 
If you select this option and do not delete the album file, the thumbnails remain as they are in 
the album.



 
Text which appears at the top (Header) and/or at the bottom (Footer) of the page. Use the 
Append combo box to insert special item codes.



 
This combo box is available when the text cursor is in either the Header or Footer entry box. 
Select an item to insert the appropriate code.

Of the Append options, only one requires further explanation, the Separator. Insert one 
separator to make the text following the separator align on the center of the page, insert a 
second one to align text to the right of the page. Additional separators are ignored.



 
These entry boxes allow you to specify the amount of space between the edges of the paper and the
position of the outer thumbnails. Headers and footers are displayed in the margin.



 
These entry boxes allow you to specify the minimum spacing between thumbnails. Album calculates 
how many thumbnails can be placed on a page without the space between them being less than 
these two figures.



 
Unit indicator displays the current unit of measure used by all the entry boxes. This is taken from 
your current Windows measurement system defined with the International option under Windows 
control panel.



 
This command is only available when Album is in an OLE session. That is, when you have 
embedded an object from album into a client program's document and you have double-clicked 
on the object (in the client program) to edit it: Album opens and the object's thumbnail is 
selected. If you edit the thumbnail's file or select another thumbnail and use this command, the 
object in the client is updated.



 
Deselecting this option hides the filenames and enables you to see more thumbnails in an 
album at any one time.



 
Ascending order is normal alphanumeric order, with numerals preceding letters. This option 
does not have any effect on the user defined arrangement.



 
The Undo command undoes only the last command applied. Some of Album's commands 
cannot be undone. When this is the case, the Edit menu displays "Can't Undo."



 
Specified filename may include the drive and path or it could just be the file extension.



 
NOT check boxes, for the Filename and Data type options can be selected to specify the 
opposite condition. For example, select the Black & White data type and click on the NOT 
option. Album identifies all files that are not Black & White.



 
You can specify multiple keywords by using the logical (Boolean) operators, AND, OR, and NOT
and separating conditions.



 
From the available options, specify the data type of image files or select Vector-graphics or 
Application-linked files.



 
Initially displays the existing description of a selected thumbnail that you can edit or, if the entry 
box is empty it means that either the selected thumbnail has no description or you have 
selected multiple thumbnails to which you can apply the same description.



 
The images contained in the active album can be sorted using the following options: Name, File 
Type, Size, Date, Description, Data Type, Resolution, Dimension, Label, and User defined. The 
order is either ascending or descending, depending on the current setting in the Preferences 
dialog box.



 
Choose from a variety of effects: Blind, Chess, Dissolve, Interlace, Louver, Random, Spiral, 
Strip, Wipe. Random uses a randomly chosen effect between each slide.



 
The time specified does not include the time it takes to read or display images. For large images
this means the time between slides may be considerably longer than the specified amount.



 
Press the Esc key to stop the slide show.



 
Choose one of the commands from the Sort sub-menu in the View menu. The available sort 
commands are: Name, Extension, Size, Date, Description, Data Type, Resolution, Dimension, 
and User Defined.



 
If you find the tool palette is too big and occupies too much of your workspace, click on the 
configuration button of the tool palette and choose "Hide Names". Once this command is 
applied, the application names disappear, the size of the shelf is reduced, and the Hide Names 
command becomes the Show Names command.



 
The Number of Tools command in the configuration menu determines the number of 
applications currently displayed in the tool palette. There are six options available, from three to 
six. To change the current number of tools displayed, click on the configuration button of the tool
palette and choose"Number of Tools", then select any of the options which appears.



 

The scroll buttons are available whenever the tool palette contains more program icons than it can display
at one time. Clicking on the scroll buttons displays more tools.



 

Clicking on a tool icon in the palette invokes that tool.



 
There is a second BROWSER.INI file on the CD-ROM. This file simply tells Browser where to 
find the albums of images on the CD-ROM. You can ignore this file.



 
This line controls the number of albums, both open and minimized, that can appear in the 
Browser workspace. The default is 12. Although technically this number can be much higher, a 
number greater than 30 is not recommended because this may limit the number of files other 
Windows applications can open. Windows allows a maximum of 255 files to be open 
simultaneously.



 
1: Default value. When an RGB True Color or HiColor image is copied to the Windows 

clipboard from Browser, its data type is converted to that of the current display mode.
0: Disables this conversion

The default value allows all applications to display a reasonable version of the copied image. 
However, if you are using applications that can themselves adjust the display of RGB True Color
and HiColor images you may wish to disable this conversion.



 
1: Default value. Data in this format is copied to the clipboard
0: Disables the copying of this format to the clipboard

When you copy images to the clipboard, Browser copies several different formats to suit 
different applications. You can choose to disable the copying of the DIB (Device-Independent 
Bitmap) and DDB (Device-Dependent Bitmap) formats by entering a value of 0. Do not disable 
both options as this will mean you cannot paste images into some other applications.



 
If you only have one CD-ROM drive you will not need to add this entry. 

If you have more than one CD-ROM drive and you have copied the CD-ROM album files to your
hard drive, you will need to use this option so that it can locate all the image files on your CD-
ROM. If you do not specify a drive, Browser assumes that the CD-ROM images contained within
the albums are on the first CD-ROM it can find.

D: or any other legal DOS drive name (E:, F:,...): specifies that all images can be found on the 
specified drive.

? Forces Browser to display a dialog box each time you try to access an album of CD-ROM 
images from your hard drive. This is necessary since the albums are "relative", i.e. the 
images contained within them should be on the same drive as the album file. When this is 
not the case, this option allows you to individually select the drive that contains the images 
for each album.





 

Open Album dialog box

Selecting the Open command from the Album menu displays the Open Album dialog box. This dialog 
box contains commands to find and open an existing album from the workspace, the shelf, floppy disks,
network drives, or other directories on your hard disk.

Filename shows the ABM file extension or a selected filename; if you know the path and filename
of the album you wish to open, enter it here

Directory shows the current directory and path
Files shows all the files in the current directory matching the entry in the Filename entry box
Directories shows the directories available in the current directory, and all available drives
Title displays the album title of a file selected in the Files list box
Description displays the description (if any) of an album file selected in the Files list box
Info opens a dialog box displaying information about a file selected in the Files list box
Browse accesses the Browse Disk for Files dialog box, use this dialog box to search for albums



 

Add Tools dialog box

Selecting the Add command from the tool palette's tool menu displays the Add Tools dialog box. This 
dialog box lets you locate programs and add their icons to the tool palette.

Filename shows the EXE file extension or a selected filename; if you know the path and filename
of the program file you wish to add, enter it here

Directory shows the current directory and path
Files shows all the files in the current directory matching the entry in the Filename entry box
Directories shows the directories available in the current directory, and all available drives
Name allows you to enter the name that will appear under the program's icon in the tool palette
Optional parameters allows you to enter text that will be added to the program's command line 

when it is executed.
Add adds a selected execution file to the tool palette. You may add as many programs as you like

in this way before closing the dialog box with the Close button.
Browse accesses the Browse Disk for Files dialog box, use this dialog box to search for 

programs



 

Browse Disk for Files dialog box

There is a Browse button in all dialog boxes that involve accessing files on disk. Clicking on this button 
displays the Browse Disk for Files dialog box. Use this dialog box to search for files on a specific drive 
or in a particular directory. This dialog box also contains sort options for found files to aid you in your 
search.

Filename defines the filename you wish to search for
Directory shows the current directory and path
Files found after scanning, shows all the files on the current path matching the entry in the 

Filename entry box
Directories shows the directories available in the current directory, and all available drives
Sort files by defines the order in which the found files are displayed
Size shows the amount of disk space occupied by a file selected in the Files found list box
Date shows when the file selected in the Files found list box was last saved
OK returns you to the dialog box from which you accessed this dialog box
Scan starts searching for files matching the specified name on the selected path



 

Copy Files dialog box

Selecting the Copy command from the Thumbnail menu displays the Copy Files dialog box. You can 
use this dialog box to copy and move the files of selected thumbnails into different directories.

Copy to allows you to enter the target path and directory to which files will be copied
Directory shows the current directory and path
Files shows any files in the current directory
Directories shows the directories available in the current directory, and all available drives



 

CGM Open Options dialog box

This dialog box appears when you choose to open an image in CGM format and click on the Options 
button. This is a very popular vector graphic format. ImagePals can read CGM files but cannot write to 
this format.

Force vector fonts controls the way fonts are converted (this option often have no visible effect)
Ignore background controls the way any background in the original is converted
Dot lines defines how styled lines are converted
Default Color Table assigns the Harvard Graphics default 256-color table to the opened image



 

DXF Open Options dialog box

This dialog box appears when you choose to open an image in DXF format and click on the Options 
button. This format supports 2-D vector graphics files.

Image controls if the graphic's original colors should be retained or converted to black on white
Background controls the color of the background (paper) when converted
Text font controls the way fonts are converted (this option often have no visible effect)
Palette specifies how many colors the original graphic contains



 

PIC Open Options dialog box

This dialog box appears when you choose to open an image in PIC format and click on the Options 
button. This is the format in which Lotus 1-2-3 saves vector type charts and graphs.

Pen determines how elements in a PIC chart or graph are converted
Image specifies the size of the image after conversion
Default resets values to their defaults



 

Photo CD Open Options dialog box

This dialog box appears when you choose to open an image in PCD format and click on the Options 
button. This format is developed by Kodak for its PhotoCD products and supports Grayscale, Indexed 
256-Color, and RGB True Color images.

Resolution allows you to select the size and resolution of the image to be read
Image Type determines the data type of the image to be read



 

Convert File Format dialog box

Selecting the Convert command from the Thumbnail menu displays the Convert File Format dialog box. 
Use this dialog box to convert image and graphics files from one file format to another.

Convert format to specifies the format to which image (or graphics) files will be converted to
Save converted files in specifies where to save the converted files: in the same directory as the 

originals or in a new directory
Options accesses the options dialog boxes for the selected target file format (if it provides 

options)

Note: All the files of selected thumbnails must be the same data type.

Other information
Supported file formats



 

Options button

The Options button in the Convert File Format dialog box displays another dialog box in which you can 
define the way files are saved in a format chosen from the Convert format to combo box. This button is 
only available for some file formats and the dialog box which appears depends on the selected file 
format.

Windows Bitmap (BMP)
Encapsulated PostScript (EPS)
JPEG file interchange format (JPEG)
Sun Raster (RAS)
Targa (TGA)
Tagged Image File (TIF)



 

TIFF Save Options dialog box

This dialog box appears when you choose to save the image in TIFF format and click on the Options 
button. It contains options to compress the image file.

Format should be chosen based on whether the image is going to be transferred to an Apple 
Macintosh or to be used on IBM-compatible PC's

Compression displays the compression options available for saving images of the current data 
type in this format

Strip size determines the size of the contiguous strips your images are divided into for saving
Use horizontal differentiation allows you to further increase the amount of compression



 

RAS Save Options dialog box

This dialog box appears when you choose to save an image in RAS format and click on the Options 
button. This is a raster file format which supports Black & White, Grayscale, Indexed 256-Color, and 
RGB True Color image data. This dialog box contains the following options:

Compression gives you the choice of saving without compression or with RLE compression
Byte order determines if Most Significant Byte (MSB) or Least Significant Byte (LSB) is placed 

first
Color order determines the order colors are encoded: blue, red, then green (BGR), or red, green,

and then blue (RGB)



 

TGA Save Options dialog box

This dialog box appears when you choose to save an image in TGA format and click on the Options 
button. It contains an option to compress the image file.

Compression gives you the choice of saving with or without RLE compression



 

JPEG Save Options dialog box

This dialog box appears when you choose to save the image in JPEG format and click on the Options 
button. It contains options to compress the image file.

Compression level determines how much an image is compressed
Subsampling allows you to improve the compression ratio for RGB True Color images



 

BMP Save Options

Determines whether the BMP file is saved in the standard Windows format or the OS/2 format. 

Bitmap type determines if the BMP file is saved in Windows or OS/2 format



 

EPS Save Options

Determines how the EPS file is saved. ASCII is the basic format that can be read by all EPS-compatible
software. Binary may not be compatible with other software, but files saved in binary format occupy 
about half as much disk space as those saved in ASCII format.

Format determines how the EPS file is saved



 

Batch Manager dialog box

Selecting the Batch Manager command in the Album menu, or double-clicking anywhere in the 
workspace, displays the Batch Manager dialog box. This dialog box displays all the albums present in 
the workspace and the operations that can be applied to them.

The Batch Manager allows you to apply the following operations to multiple albums at the same time: 
Delete, Minimize, Print Thumbnails, Put on Shelf, Search, Sort by, View All, View Partial, View 
Thumbnails, and View Filenames. 

Operation lists all the commands that can be applied to multiple albums
Albums displays the titles of albums in the workspace
OK closes the dialog box and applies the chosen operation to selected albums
Select All selects all the albums in the workspace
Deselect deselects any selected albums

Other information
Delete
Minimize
Print Thumbnails
Put on shelf
Search
Sort by, View All, View Partial, View Thumbnails, View Filenames



 

Print Image dialog box

Selecting the Print: File Content command in the Album menu displays the Print Image dialog box. You 
can use this dialog box to print images of a selected thumbnails to any Windows-compatible output 
device. Before you print, make sure that your printer is turned on, connected and selected in the 
Windows Printer Setup dialog box.

Printer shows the currently selected printer (selected in the Printer Setup dialog box)
Title allows you to enter text that will appear above printed images (the default "&f" prints the 

image's filename)
Copies allows you to enter the number of copies to print
Scale to fit the page scales images to print as large as possible on the output page
Center the image horizontally and vertically allow you to choose where the image prints on the

output page
Start from top left corner determines the exact positioning of an image on the output page



 

Print Thumbnails dialog box

Selecting the Print: Thumbnails command from the Album menu displays the Print Thumbnails dialog 
box. This dialog box lets you choose the information which appears in the printout. You can also use it 
to specify the number of copies to print, the fonts to use, and set the margins for printing.

Printer shows the currently selected printer (selected in the Printer Setup dialog box)
Number of copies allows you to enter the number of copies to print
Filenames and Descriptions allow you to choose to print filenames and descriptions below their 

thumbnails
Header and Footer allow you to enter text that will appear on the output pages
Append allows you to enter specific information items into the Header and Footer texts
Font and Size set the typeface and size to be used for text on the output pages
Margins accesses the Set Margins dialog box in which you can define the setup of the output 

pages



 

Preferences dialog box

Selecting the Preference command from the Album menu displays the Preferences dialog box. You can 
use this dialog box to customize some features of U-Lead Browser. Some of the options include the 
changing of the arrangement of images in albums, the display of images and their thumbnails, and 
several other features.

Display filenames while in thumbnail mode displays filenames under their thumbnails
Minimize on use minimizes Album when you open another application from the tool palette or by 

double-clicking on an application-linked file
Sort thumbnails in ascending order causes thumbnails to be displayed in normal alphanumeric

order
View images with common palette displays all images on a 256-color display using the system 

palette
Don't care about background quality causes only the active image to be displayed as well as 

possible
Monitor gamma determines the amount the display of images is displayed to accommodate for 

differences in working environments
Swap Path allows you to allocate additional working space
VGA Palette enables you to adjust the display of images on 16-color displays



 

Set Working Drives and Directories dialog box

Clicking on the Swap Path... button in the Preferences dialog box displays the Set Working Drives and 
Directories dialog box. You can use this dialog box to specify working directories to be used when there 
is insufficient space to perform an operation using your system memory and the available space in your 
TEMP directory.

1. shows your current TEMP directory defined in your AUTOEXEC.BAT file
2.,3.,4. allow you to enter additional drives and directories which will provide extra working space
OK returns you to the Preferences dialog box



 

VGA Palette dialog box

Clicking on the VGA Palette... button in the Preferences dialog box displays the VGA Palette dialog box.
This button is available when you are using a 16-color display. You can use this dialog box to bypass 
the standard VGA palette to improve the display of Grayscale images and make the Display thumbnails 
in Grayscale option (in the Create Album dialog box) available.

Bypass VGA palette to enable use of 16 grays causes Grayscale images to be displayed with 16 
grays

Compatibility test tests to see if your display card is compatible with this feature
OK returns you to the Preferences dialog box



 

Configure Status Line dialog box

Clicking on the album's status line configuration button displays the Configuration Status Line dialog 
box. This dialog box contains options to customize the information which appears in the album's status 
line when a single thumbnail is selected in the album.

Element contains information items that you can display in the status line
Status line contains the information items currently displayed in the status line
Short format when selected, abbreviated information items, without headings appear in the 

status line
Add >> moves information items selected from the Elements list box into the Status line list box
<< Remove removes selected information items from the Status line list box, returning them to 

the Element list box
Remove All removes all information items from the Status line list box
Up and Down move a selected information item up or down in the Status line list box



 
Please see your Windows documentation or Windows on-line Help for more information about 
this command.



 
Use this to limit the file search to a specific file, filename, or file extension. Enter "*.*" to list all 
files in the current path.



 
Filenames, with full paths, are listed in the order they are found. To change the order use the 
Sort files by options.



 
The selected directory and all subdirectories below it are searched. Press the Esc key to abort 
scanning.



 
Files are originally displayed in the order they are found. You can sort by Name, Type, Size, and
Date/Time. Sorted files can appear in ascending or descending order. Select an option and the 
files are sorted automatically.



 
If you have found and selected a file from the files found list box, its path and filename (or just 
path) appear in the Filename entry box of the original dialog box.



 
Four sizes are available from 48x48 to 96x96. The files of albums with larger thumbnails will be 
slightly larger on disk but give you better representation of images and graphics. Application-
linked files' icons are always 32x32, so for these, the smallest size allows you to display more 
thumbnails at one time without reducing the visual impact of each.



 
This option is only available when you are using a 16-color display and you have selected 
Bypass VGA palette to enable use of 16 grays in the VGA Palette dialog box.



 
Should be chosen based on whether the image is going to be transferred to an Apple Macintosh
or be used on IBM-compatible PC's.



 
This option causes styled lines to be converted to thin dotted lines. If this option is not selected, 
styled lines are converted to thick solid lines.



 
Set this option correctly or else some of the colors (from 8 to 15 in the color table) will be read 
incorrectly



 
Displays the compression options available for saving images of the current data type in the 
TIFF format.



 
This option has little effect on uncompressed files, so we suggest you use the default of 8 for 
these. For compressed files, the larger the strip size, the greater the amount of compression 
possible. Some applications will not read TIFF files which are saved with large strip sizes. For 
these applications use 4 K strip sizes.



 
The effect of this routine depends on the nature of your image. For some images (containing 
random changes in color and many stray pixels) it will have little or no effect, for others (with 
large areas of continuous color) it will improve the compression considerably.



 
This option has no direct relationship with the actual compression ratio achieved, but generally, 
the higher the level, the greater the amount of compression.



 
This option is unavailable for Grayscale images.



 
ASCII is the basic format that can be read by all EPS-compatible software. Binary may not be 
compatible with other software, but files saved in Binary format will occupy about half as much 
disk space as those saved in ASCII format. 



 
Within this combo box, you can select multiple files by dragging down the list and by using the 
SHIFT and CTRL keys in conjunction with the mouse.



 
Scaling maintains the aspect ratio of the image. When this option is not selected, the image 
prints at the size determined by its resolution.



 
If neither of these is selected, images print starting from the top left corner. If both are selected, 
the image is centered on the page.



 
Position is relative to the top left corner of the printable area of the page. These options are 
disabled when you select the corresponding centering option or Scale to fit the page.



 
This option is available if you are using a 256-color display. This is an important option if you 
want to view Grayscale images at the same time as color images on a 256-color display, or 
compare any sort of image on a 256-color display.



 
This affects the speed of display updating on 256-color displays. When selected, Enhancer only 
updates the active image. Images in the background may appear distorted, blurred, or grayed. 
The content of the background images is not changed, only the way they are displayed. If you 
wish to compare two or more images, deselect this option.



 
Determines how much the display of images is adjusted to accommodate for differences in 
display adapters and monitors. Use this feature to display images correctly on all types of 
computer display. When this option is disabled, or set to 1.00, the display of images is not 
adjusted. 



 
These would normally be different drives unless your access rights to particular directories allow
you different space allocations on the same drive.



 
Before you select this option you should test your display card to see if it is compatible with the 
Compatibility test provided.



 
When you press this button, the color squares on the right become squares of different grays, if 
your card is compatible. If your card is incompatible, nothing will happen or, at worst, you will 
have to restart your computer.



 
The item at the top of the Status line list is displayed first, on the left of the status line with the 
other items following.



 
Choose one of the commands from the Sort sub-menu in the View menu. The available sort 
commands are: Name, File Type, Size, Date, Description, Data Type, Resolution, Dimension, 
and User Defined. The User Defined order is the order by which images were inserted into the 
album.



 
To move thumbnails, choose "Cut" from the Edit menu to remove them from one album and 
then, after making another album active, choose "Paste" to place them in the second album, or 
simply drag the thumbnails from one album into another.



 
To add files to an album using the "Drag and Drop" feature of Windows 3.1, drag them from the 
File Manager and drop them into an album in the workspace.



 
To move thumbnails onto the clipboard, select them in an album and then choose "Cut" from the
Edit menu. The selected thumbnails can then be pasted into another album using the Paste 
command.



 
Select the thumbnails you want to delete from the album and then choose "Clear" from the Edit 
menu. Selected images are deleted from the album but not from disk, which means you can still 
reinsert them to the same or another album.



 
To upgrade to ImagePals 1.2 contact your local distributor or:

U-Lead Systems, Inc. (North America):
970 West 190th Street, Suite 520,
Torrence, CA 90502
Tel: (310) 523-9393
Fax: (310) 523-9399

U-Lead Systems, Inc. (International)
12F-A, 563 Chung Hsiao East Rd, Sec. 4,
Taipei, Taiwan R.O.C.
Tel: + 886 (2) 764-8599
Fax: + 886 (2) 764-9599







 

Finding files

There is a Browse button in all dialog boxes which involve opening or accessing files on disk. Use this 
button as follows:

1. Click on the Browse button. The Browse Disk for Files dialog box appears.
2. Decide on the disk drive and directory you want to browse. Use the Directories list box to access the 

drive and directory.
3. Click on the Scan button. The path you have specified is searched for files with a name matching 

that in the Filename entry box. Matching files are then listed in the files found list box.
4. Select the file you want to open from the files found list box by clicking on it.
5. Click OK. The Browse Disk for Files dialog box closes, returning you to the original dialog box. The 

filename and path you found appear in the Filename entry box.

Other information
Browse Disk for Files dialog box



 

Exiting

When you have finished your current session you are ready to exit Album. Exiting closes the application
window and returns you to Windows Program Manager. You can exit by:

double-clicking on the application control menu box.
clicking on the application control menu box and choosing "Close".
choosing the Exit command in the File menu.





 

Procedures

The following topics contain procedures which will help you work efficiently with U-Lead Browser. Before
you start a procedure you may find it useful to select the Always on Top option from this window's Help 
menu and rearrange the windows on your screen so that you can see both this one and U-Lead 
Browser. To learn how to perform a particular operation, click on the appropriate button.

Browser basics
Getting information
Managing thumbnails
Locating thumbnails
Working with files
Using the Batch Manager
Selecting thumbnails in an album
Using albums from the shelf
Copying filenames
Customizing the tool palette
Creating a slide show
Viewing original files
How to link and embed objects



 

Tool palette

The tool palette, on the right side of the workspace, provides a link between the images you are 
organizing and your frequently used applications. This palette contains the following:

Album Shelf a place where you can store albums
Tool button can be used to choose the programs which appear and how they appear in the tool 

palette
Scroll buttons displays tools contained in the tool palette
Tool icons allows you to invoke and transfer control to a chosen program



 

Browser basics

The following are some procedures you'll be using regularly. To learn how to perform a particular 
operation, click on the appropriate button.

Opening an album
Finding files
Deleting albums
Exiting Album



 

Opening an album

The Open command in the Album menu can be used to open albums from the workspace, the shelf, 
floppy disks, network drives, or other directories on your hard disk. Use the Open command as follows:

1. Choose "Open" from the Album menu. The Open Album dialog box appears.
2. If the album you want to open is not in the current directory, use the Directories list box to locate the 

album file.
3. Select the album to open from the Files list box by clicking on it. If you are unsure which album file to

open, the album's title and description are shown under the Files list box when you click on a 
filename.

4. Click OK. The dialog box closes and the album appears in the workspace.

Other information
Open Album dialog box
Accessing other albums



 

Deleting albums

If you want to remove an album from the workspace, you can place it on the shelf or delete it. When 
deleting an album from the workspace, you can also choose to delete the album and image files (if they 
are not read-only) from disk. Removing an album from the workspace, without deleting the album file, 
allows you to reopen the album using the Open command. To delete an album:

1. Select the album you want to delete by clicking on its title bar, or if minimized, double click on the 
album icon.

2. Choose "Delete" from the Album menu. The Delete Album dialog box appears.
3. Select to delete the album file and choose whether or not to delete the files it manages.
4. Click OK. The dialog box closes and the album is removed from the workspace with selected files 

being deleted.

Other information
Delete Album dialog box



 

Getting information

There are several ways to view information about albums and the files associated with the thumbnails it 
contains. To learn how to access this information, click on the appropriate button.

Albums
Files



 

Managing thumbnails

U-Lead Browser allows you to place thumbnails of images into a new album or into an existing one. 
Initially the thumbnails are arranged in an album in the order they were added. Following are ways by 
which you can insert and arrange thumbnails into albums:

Moving thumbnails from one location to another
Moving thumbnails onto the clipboard
Deleting thumbnails from an album
Arranging thumbnails in alphabetical or numerical order
Using the "drag-and-drop" feature of Windows 3.1

Note: Thumbnails of Read-only albums can be copied but not moved into another album. To copy a 
thumbnail from a Read-only album into another album, hold the CTRL key down while dragging and 
dropping. If you drag-and-drop a thumbnail from a Read-only album into another album without the 
CTRL key held down, an error message will appear.

Other information
Copying thumbnails



 

Locating thumbnails

Apart from visually browsing through an album, you can search for the attributes of particular files:

Search for the attributes of a thumbnail's file



 

Working with files

U-Lead Browser's organization of files is not restricted to arranging them in albums. You can also 
manage them on disk. The file management commands can be applied to any number of images 
selected from the active album. However, the commands will not work if the original files cannot be 
found on disk. With Album you can:

Copy files
Convert image and graphics files from one file format to another



 

Copying files

Copying files allows you to copy any number of files to any writable directory. You can use this feature 
to copy files from CD-ROM to your local drive as follows:

1. Select the thumbnail whose file you want to copy.
2. Choose "Copy" in the Thumbnail menu. The Copy Files dialog box appears.
3. Type in a new filename and/or full path for the copied file.
4. Click OK. The dialog box closes and copying begins.

Other information
Copy Files dialog box



 

Converting image and graphics files

You can convert image and graphics files from a variety of file formats to a common one. The files of the
thumbnails you choose may all be of the same format or different ones but they must be of the same 
data type.

When converting image and graphics files, you choose where to save the converted files. To convert a 
file:

1. Select the thumbnail whose file you want to convert.
2. Choose "Convert" from the Thumbnail menu. The Convert File Format dialog box appears.
3. Choose a file format to convert to in the Convert format to combo box. The formats available depend

upon the data type of your selected image.
4. Decide where you want to save the converted files. If you select the Another subdirectory option, 

type in the path and directory in the corresponding entry box.
5. Click OK. The dialog box closes and file conversion begins.

Other information
File Formats
Convert File Format dialog box



 

Using the Batch Manager

The Batch Manager allows you to apply a command to multiple albums in a single operation. The 
commands available through the Batch Manager are: Delete, Minimize, Print thumbnails, Put on Shelf, 
Search, Sort by, View All, View Partial, View Thumbnails, and View Filenames. These operations can 
only be carried out to albums in the workspace. If the albums you want to work on are on the shelf, 
move them into the workspace before bringing up the Batch Manager. To use the Batch Manager:

1. Choose "Batch Manager" in the Album menu or double click in the workspace. The Batch Manager 
dialog box appears.

2. Select an operation to carry out in the Operation combo box.
3. Select the albums you want the operation applied to in the Albums list box. You can use the Select or

Deselect buttons to select the images in the list box.
4. Click OK. The operation is applied to all selected albums.

Other information
Batch Manager dialog box
Using albums from the shelf



 

Selecting thumbnails in an album

Before applying commands to individual thumbnails in an album, you first have to select them. When a 
thumbnail is selected, its filename is highlighted. A selected thumbnail remains selected until you 
deselect it. You can select thumbnails or filenames in the following ways:

To select one, click on it. Any other selected thumbnails in the album are deselected.
To select a range, click on the first in the range, then hold down the Shift key and click on the last.
To select or deselect individual thumbnails without affecting previous selections, hold the Ctrl key 

down and click on it.
Choose any of the Select commands contained in the Edit menu.



 

Using albums from the shelf

The albums you place on the shelf remain there until you want to use them again. To use an album from
the shelf:

1. Click on the shelf button in the tool palette. The Album Shelf dialog box appears.
2. Select the album you want to use from the Albums on shelf list box by clicking on it.
3. Click on "<=". The selected album is transferred to the Albums in workspace list box and appears as 

an icon in your Album workspace.
4. Double-click on the album icon to display the album.

Other information
Album Shelf dialog box



 

Copying filenames

Copying filenames saves you the effort of remembering a long path and filename as well as reducing 
the time you may spend searching for a file. To copy:

1. Select a thumbnail in the active album.
2. Choose "Copy:Filename" in the Edit menu. The filename of the selected thumbnail is copied to the 

clipboard.
3. Open the application to which you want to copy the filename.
4. Display the Open or Place dialog box of the application.
5. Position the cursor in the Filename entry box.
6. Press Shift and Ins (or, in Windows 3.1, Ctrl and V). The copied filename appears in the Filename 

entry box.



 

Copying thumbnails

Copying thumbnails can be used to move thumbnails between albums and create duplicate copies of 
the same thumbnail in more than one album. To copy: 

1. Select the thumbnails you wish to copy in the active album.
2. Choose "Copy:Thumbnail" in the Edit menu. The selected thumbnails are copied to the clipboard.
3. Open the album into which you want to copy the thumbnails.
4. Choose "Paste" from the Edit menu. The thumbnails are inserted in the positions determined by the 

album's current sort mode



 

Album information

The Album Information dialog box contains information about the selected album. There are several 
ways to access the Album Information dialog box:

in the Open Album dialog box, select an album and click on the Info button.
choose the Information command from an album's control menu.
in the workspace, select the album you want information on by clicking on its title bar or icon, then

choose "Album Information" from the View menu.
in the Restore Album dialog box, click on the Info button.
in the Album Shelf dialog box, select an album from the Albums in workspace or Albums on shelf 

list boxes and click on the Info button.



 

File information

Once a file is inserted into an album, some information is collected. Following are ways by which you 
can view this information:

select a thumbnail and choose "File Information" from the View menu. The File Information dialog 
box appears.

select a thumbnail and review the information displayed in the status line. If you want to display 
different information, click on the configuration button in the album's status line. In the Configure Status 
Line dialog box that appears, choose the information you want displayed.

when viewing filenames instead of thumbnails in an album, information is displayed to the right of 
the filename.

Other information
Configure Status Line dialog box



 

Searching for a file's attributes

If you are using Album, chances are you are maintaining a large number of files. Occasionally you may 
forget exactly where you have placed a particular one. Within Album, you can search for files in the 
active album as follows:

1. Choose "Search" in the Thumbnail menu. The Search for Files dialog box appears.
2. Define your search criteria by selecting the limiting criteria and making the necessary entries in the 

entry boxes. If you define more than one criteria, only thumbnails of files matching all the criteria will 
be found.

3. Click on OK. If there are any files matching your criteria, the Go to Thumbnail dialog box appears. If 
there aren't any matching the criteria, a message to that effect appears.

4. Select the filename you are searching for in the Thumbnails found list box.
5. Click on the Goto button. A yellow arrow appears in the album indicating the selected thumbnail.
6. Click on the Close button. The Go to Thumbnails dialog box closes.

Other information
Search for Thumbnails dialog box
Go to Thumbnail dialog box



 

Customizing the tool palette

The tool palette can be customized to meet your individual needs. Use the tool button, located below 
the shelf, to choose the programs which appear and how they are displayed. You can customize and 
change the appearance of the tool palette by:

Adding a program
Removing a program
Modifying a program
Rearranging the programs
Hiding the names of programs
Changing the number of program icons



 

Adding a program

Adding frequently used programs into the tool palette makes it easier for you to transfer between Album
and those programs. Once a program icon appears in the tool palette, simply click on it to open the 
corresponding application. To add:

1. Click on the tool button in the tool palette and choose "Add" from the tool menu. The Add tools dialog
box appears.

2. If you know the path and filename of the program, enter them in the Filename entry box. If not, use 
the Directories list box and the Files list box to look for the program.

3. Enter a name in the Name entry box for the program you are adding. If you do not enter a new 
name, the default name of the program is used.

4. Click on the Add button. The program icon with the name you specified or its default name appears 
in the tool palette. If you want to add more programs to the palette, repeat steps 2 to 4.

5. Click on the Close button. The dialog box closes.

When using Windows 3.1, you can easily add programs by dragging execution files from the Program 
Manager to the tool palette.

Other information
Add Tools dialog box



 

Removing a program

The tool palette can contain almost any number of program icons, but we suggest you limit the 
programs to only those you frequently use. Program icons can easily be removed from the tool palette. 
To remove a program from the tool palette:

1. Click on the tool button in the tool palette and choose "Remove" from the tool menu. The Remove 
tools dialog box appears.

2. Select the program you want to remove in the Tools list box.
3. Click on the Remove button. The selected program disappears from the Tools list box and the tool 

palette. If you want to remove more than one program, repeat steps 2 and 3.
4. Click on the Close button. The dialog box closes.

Other information
Remove Tools dialog box



 

Modifying a program

When a program is added to the tool palette, you are given the opportunity to enter a name for the 
program and add optional parameters. You can change the name and parameters of the program by 
using the Modify command. To modify a program:

1. Click on the tool button in the tool palette and choose "Modify" from the tool menu. The Modify Tools 
dialog box appears.

2. Select the program you want to modify in the Tools list box. The name and optional parameters of 
the selected program appear in the Name and Optional parameters entry boxes.

3. Change the name, optional parameters, or both.
4. Click on the Modify button. The program is modified according to your changes. If you want to modify

another program, repeat steps 2 to 4.
5. Click on the Close button. The dialog box closes.

Other information
Modify Tools dialog box



 

Rearranging programs icons

The arrangement of the program icons in the tool palette depends upon the order in which you added 
them. When a program is added, it automatically goes to the end of the list but you can change this 
sequence. For example, you might want to position your most frequently used programs at the top of 
the tool palette and the least used ones lower down. To rearrange the sequence:

1. Click on the tool button in the tool palette and choose "Rearrange" from the tool menu. The 
Rearrange Tools dialog box appears.

2. Select a program in the Tools list box.
3. Click on one of the buttons: Top (to move the program to the top of the list), Bottom (to move it to the

bottom), Up (to move it one step up), and Down (to move it one step down).
4. Click OK. The dialog box closes and the programs in the tool palette appear in the new sequence.

Other information
Rearrange Tools dialog box



 

The shelf, at the top of the tool palette, provides a place to store albums. It can contain up to 142 
albums and can be used to find albums, whether they are on the shelf or in the workspace. The albums 
in the workspace can be placed onto the shelf in any of the following ways:

Drag an album icon onto the shelf button.
From the Shelf dialog box, select the album you want to place onto the shelf from the Albums in 

workspace list box, then click on "=>".
Click on an album's control menu box (or click once on an album icon) and, from the control 

menu, choose "Put on Shelf".
Use the Batch Manager's Put on Shelf operation.

Other information
Album Shelf dialog box



 

The tool button is located below the shelf in the tool palette. Use this button to choose the programs 
which appear and how they are displayed in the tool palette. When you click on this button, the tool 
menu drops down containing all the commands that can be applied to customize the appearance of the 
tool palette. 

Add a frequently used program to the tool palette
Remove a program from the tool palette
Modify the name and optional parameter of a program in the tool palette
Rearrange the order of program icons in the tool palette
Hide/Show Names allows you to change the size of the tool palette by hiding or showing the 

names of programs
Number of Tools allows you to set the number of programs displayed in the tool palette



 
Viewing original files

You can view the original file associated with a thumbnail by double-clicking on the thumbnail. Exactly 
what happens depends on the original file:

Application-linked files
Double-clicking on the thumbnail of an application-linked file invokes its linked application which 
subsequently opens and displays the file.

Image and Graphics files 

Double-clicking on the thumbnail of an image or graphics file displays the image or graphic in a viewing 
window. This viewing window provides two menus:

Edit menu contains commands to select and deselect the image and, after selecting it, copying it onto 
the clipboard.

View menu contains commands that change the view of the displayed image or graphic.



 

Creating a Slide Show

The slide show feature allows you to display image and graphics files from a specific album with any 
one of eighteen different transition effects. Each file is displayed at its actual view, centered on a black 
screen until it is replaced by the next one in the presentation. The transition effect controls the way it is 
replaced. To create a slide show:

1. Within an album, select the thumbnails of image and/or graphics files you wish to display. If no 
thumbnails are selected, all qualified files associated with thumbnails in the active album are 
displayed.

2. Choose "Slide Show" from the View menu. The Slide Show dialog box appears.
3. In the Transition area, select a transition effect and whether you want to change the slides yourself 

(manually) or let Album do it for you (automatically).
4. Click OK. The dialog box closes and:

If you selected Automatic triggering, the slide show starts.
If you selected Manual triggering, the Slide Show controls dialog box appears displaying the manual 
controls. Click OK to begin the slide show.

Note: Application-linked files cannot be displayed in slide shows.

Other information
Slide Show dialog box
Slide Show Control dialog box



 

How to embed objects

Linking and embedding objects can vary from program to program. Before you do this we suggest that 
you read your client's program documentation.

Basically there are two routes to embedding (one of which can also be used for linking). One starts from
the client program, the other from the server. To embed objects starting from the:

client
server



 

Embedding from the Client

To embed an object starting from the client:

1. Open or create a document in the client program and select the client's Insert Object command (or 
similar). The Insert Object dialog box appears.

2. In the Object type list box, select U-Lead Browser Image/Graphic.
3. Click OK. The dialog box disappears and U-Lead Browser appears.
4. Locate the album containing the thumbnail of the image or graphic you want and select it.
5. From U-Lead Browser's Album menu, choose "Update client" (client is the name of the client 

program).
6. Either Exit U-Lead Browser or switch to the client program. The object you selected appears in the 

active document in the client program's workspace.

Note: In U-Lead Browser, the Update command is disabled if you are not in OLE session (i.e. there is 
no client program), or there are no qualified thumbnails or more than one qualified thumbnail is 
selected.



 

Embedding or linking from the server

To embed an object starting from the server:

1. Starting from U-Lead Browser, locate the album containing the thumbnail of the image or graphic 
you want and select it.

2. From the Edit menu, select "Copy: File Content".
3. Exit U-Lead Browser and open the client program containing the document into which you want to 

place the object.
4. Select the client program's Paste Special command. The Paste Special dialog box appears.
5. In the Data Type list box, select "U-Lead Browser Image/Graphic.
6. Click on Paste. The dialog box closes and the object is embedded in the client program's active 

document.

Note: In some client programs, you can use their normal Paste command to embed an object.




